
101 Innovation Drive
San Jose, CA 95134
www.altera.com

DDR3 SDRAM High-Performance
Controller User Guide

Software Version: 9.0
Document Date: March 2009

http://www.altera.com


Copyright © 2009 Altera Corporation. All rights reserved. Altera, The Programmable Solutions Company, the stylized Altera logo, specific device designations, and all other
words and logos that are identified as trademarks and/or service marks are, unless noted otherwise, the trademarks and service marks of Altera Corporation in the U.S. and other
countries. All other product or service names are the property of their respective holders. Altera products are protected under numerous U.S. and foreign patents and pending ap-
plications, maskwork rights, and copyrights. Altera warrants performance of its semiconductor products to current specifications in accordance with Altera's standard warranty,
but reserves the right to make changes to any products and services at any time without notice. Altera assumes no responsibility or liability arising out of the application or use of
any information, product, or service described herein except as expressly agreed to in writing by Altera Corporation. Altera customers are advised to obtain the latest version of
device specifications before relying on any published information and before placing orders for products or services.

UG-01021-4.0





iv
Partial Writes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–8
Partial Bursts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–9
ECC Latency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–9

Example Design . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–10
Example Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–10

Interfaces & Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–12
Interface Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–12

Writes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–12
Reads  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–14
User Refresh Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–16
Self-Refresh and Power-Down Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–17
Auto-Precharge Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–18
Initialization Timing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–18

Signals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–19

Appendix A. ECC Register Description
ECC Registers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A–1

Register Bits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A–3

Additional Information
Revision History  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  Info–1
How to Contact Altera  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  Info–1
Typographic Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  Info–1
DDR3 SDRAM High-Performance Controller User Guide © March 2009 Altera Corporation



© March 2009 Altera Corporation
1. About This MegaCore Function
Release Information
Table 1–1 provides information about this release of the DDR3 SDRAM High-
Performance Controller MegaCore® functions.

Altera® verifies that the current version of the Quartus® II software compiles the 
previous version of each MegaCore function. The MegaCore IP Library Release Notes 
and Errata report any exceptions to this verification. Altera does not verify 
compilation with MegaCore function versions older than one release.

Device Family Support
MegaCore functions provide either full or preliminary support for target Altera 
device families, as described below:

■ Full support means the MegaCore function meets all functional and timing 
requirements for the device family and may be used in production designs

■ Preliminary support means the MegaCore function meets all functional 
requirements, but may still be undergoing timing analysis for the device family; it 
may be used in production designs with caution

Table 1–2 shows the level of support offered by the DDR3 SDRAM High-Performance 
controller to each of the Altera device families.

Table 1–1. DDR3 SDRAM High-Performance Controller Release Information

Item Description

Version 9.0

Release Date March 2009

Ordering Codes IP-SDRAM/DDR3

Product IDs 00C2

00CO (ALTMEMPHY Megafunction)

Vendor ID 6AF7

Table 1–2. Device Family Support

Device Family Support

Arria® II GX Preliminary

Stratix® III Full 
Stratix IV Preliminary

HardCopy® III Preliminary 

HardCopy IV E Preliminary 

Other device families No support
DDR3 SDRAM High-Performance Controller User Guide

www.altera.com/literature/rn/rn_ip.pdf
www.altera.com/literature/rn/rn_ip.pdf


1–2 Chapter 1: About This MegaCore Function
Features
Features
■ Integrated error correction coding (ECC) function

■ Power-up calibrated on-chip termination (OCT) support

■ Half-rate support for Stratix III and Stratix IV devices 

■ SOPC Builder ready

■ Automatically generated memory simulation model simplifies simulation flow 

■ Support for ALTMEMPHY megafunction

■ Support for industry-standard DDR3 SDRAM devices and modules

■ Optional support for self-refresh and power-down commands

■ Optional support for auto-precharge read and auto-precharge write commands

■ Optional user-controller refresh

■ Optional Avalon® Memory-Mapped (Avalon-MM) local interface

■ Easy-to-use MegaWizardTM interface

■ Support for OpenCore Plus evaluation

■ Support for the Quartus II IP Advisor

■ IP functional simulation models for use in Altera-supported VHDL and Verilog 
HDL simulators

General Description
The Altera DDR3 SDRAM High-Performance Controller MegaCore functions provide 
simplified interfaces to industry-standard DDR3 SDRAM. The MegaCore functions 
work in conjunction with the Altera ALTMEMPHY megafunction.

f For more information on the ALTMEMPHY megafunction, refer to the External 
Memory PHY Interface Megafunction User Guide (ALTMEMPHY).

Figure 1–1 on page 1–3 shows a system-level diagram including the example design 
that the DDR3 SDRAM High-Performance Controller MegaCore functions create for 
you. 
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Chapter 1: About This MegaCore Function 1–3
MegaCore Verification
The MegaWizard Plug-In Manager generates an example design that instantiates an 
example driver and your DDR3 SDRAM high-performance controller custom 
variation. The controller instantiates an instance of the ALTMEMPHY megafunction 
which in turn instantiates a PLL and DLL. You can optionally instantiate the DLL 
outside the ALTMEMPHY megafunction in order to share the DLL between multiple 
instances of the ALTMEMPHY megafunction. 

The example design is a fully-functional design that you can simulate, synthesize, and 
use in hardware. The example driver is a self-test module that issues read and write 
commands to the controller and checks the read data to produce the pass/fail and test 
complete signals. 

MegaCore Verification
MegaCore verification involves simulation testing. Altera performs extensive 
random, directed tests with functional test coverage using industry-standard Denali 
models to ensure the functionality of the DDR3 SDRAM high-performance controller. 
In addition, Altera has carried out a wide variety of gate-level tests of the DDR3 
SDRAM high-performance controller to verify the post-compilation functionality of 
the controller. 

Figure 1–1. System-Level Diagram
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Performance and Resource Utilization
Performance and Resource Utilization
Table 1–3 shows maximum performance results for the DDR3 SDRAM high-
performance controller using the Quartus II software, version 9.0.

f For more information on device performance, refer to the relevant device handbook.

Table 1–4 shows typical sizes for the DDR3 SDRAM high-performance controller on 
Stratix III and Stratix IV devices.

Installation and Licensing
The DDR3 SDRAM High-Performance Controller MegaCore functions are part of the 
MegaCore IP Library, which is distributed with the Quartus II software and 
downloadable from the Altera website, www.altera.com.

f For system requirements and installation instructions, refer to Quartus II Installation & 
Licensing for Windows and Linux Workstations.

Figure 1–2 shows the directory structure after you install the DDR3 SDRAM High-
Performance Controller MegaCore functions, where <path> is the installation 
directory. The default installation directory on Windows is c:\altera\<version>; on 
Linux it is /opt/altera<version>.

Table 1–3. Maximum Performance for DDR3 Half Rate Controller

Device Rate  System fMAX (MHz)

Stratix III Half Rate 533

Stratix IV Half Rate 533

Table 1–4. Typical Size—Stratix III & Stratix IV Devices

Local Data Width 
(Bits)

Memory Width 
(Bits)

Combinational 
ALUTs

Dedicated Logic 
Registers

Memory
(M9K)

32 8 4,416 3,199 3

64 16 5,012 3,735 4

256 32 8,365 6,806 13

288 64 8,945 7,319 14
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Chapter 1: About This MegaCore Function 1–5
Installation and Licensing
You need a license for the MegaCore function only when you are completely satisfied 
with its functionality and performance, and want to take your design to production. 

If you want to use the DDR3 SDRAM High-Performance Controller MegaCore 
function, you can request a license file from the Altera web site at 
www.altera.com/licensing and install it on your computer. When you request a 
license file, Altera emails you a license.dat file. If you do not have Internet access, 
contact your local Altera representative.

OpenCore Plus Evaluation
With Altera’s free OpenCore Plus evaluation feature, you can perform the following 
actions:

■ Simulate the behavior of a megafunction (Altera MegaCore function or AMPPSM 
megafunction) within your system

■ Verify the functionality of your design, as well as evaluate its size and speed 
quickly and easily

■ Generate time-limited device programming files for designs that include 
MegaCore functions

■ Program a device and verify your design in hardware

You need to purchase a license for the megafunction only when you are completely 
satisfied with its functionality and performance, and want to take your design to 
production.

f For more information on OpenCore Plus hardware evaluation using the DDR3 
SDRAM high-performance controller, refer to AN 320: OpenCore Plus Evaluation of 
Megafunctions.

Figure 1–2. Directory Structure

<path>

ddr3_high_perf
Contains the DDR3 SDRAM High-Performance Controller MegaCore function files.

doc
Contains the documentation for the DDR3 SDRAM High-Performance Controller MegaCore function.

lib
Contains encypted lower-level design files and other support files.

common
Contains shared components.

Installation directory.

ip
Contains the  Altera MegaCore IP Library and third-party IP cores.

altera
Contains the  Altera MegaCore IP Library.
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Installation and Licensing
OpenCore Plus Time-Out Behavior
OpenCore Plus hardware evaluation can support the following two modes of 
operation:

■ Untethered—the design runs for a limited time

■ Tethered—requires a connection between your board and the host computer. If 
tethered mode is supported by all megafunctions in a design, the device can 
operate for a longer time or indefinitely

All megafunctions in a device time out simultaneously when the most restrictive 
evaluation time is reached. If there is more than one megafunction in a design, a 
specific megafunction’s time-out behavior may be masked by the time-out behavior 
of the other megafunctions.

1 For MegaCore functions, the untethered time-out is 1 hour; the tethered time-out 
value is indefinite. 

Your design stops working after the hardware evaluation time expires and the 
local_ready output goes low.
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2. Getting Started
Design Flow
Figure 2–1 shows the stages for creating a system with the DDR3 SDRAM High-
Performance Controller MegaCore function and the Quartus II software. The sections 
in this chapter describe each stage.

Figure 2–1. Design Flow 
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Select Flow
Select Flow
You can parameterize the DDR3 SDRAM High-Performance Controller MegaCore 
function using either one of the following flows:

■ SOPC Builder flow

■ MegaWizard Plug-In Manager flow

Table 2–1 summarizes the advantages offered by the different parameterization flows.
.

SOPC Builder Flow
The SOPC Builder flow allows you to add the DDR3 SDRAM High-Performance 
Controller MegaCore function directly to a new or existing SOPC Builder system. You 
can also easily add other available components to quickly create an SOPC Builder 
system with a DDR3 SDRAM High-Performance Controller, such as the Nios II 
processor, external memory controllers, and scatter/gather DMA controllers. SOPC 
Builder automatically creates the system interconnect logic and system simulation 
environment.

f For more information about SOPC Builder, refer to volume 4 of the Quartus II 
Handbook. For more information about how to use controllers with SOPC Builder, 
refer to AN 517: Using High-Performance DDR, DDR2 and DDR3 SDRAM With SOPC 
Builder. For more information on the Quartus II software, refer to the Quartus II Help. 

Specify Parameters
To specify DDR3 SDRAM High-Performance Controller parameters using the SOPC 
Builder flow, follow these steps:

1. In the Quartus II software, create a new Quartus II project with the New Project 
Wizard.

2. On the Tools menu, click SOPC Builder.

3. For a new system, specify the system name and language.

4. Add DDR3 SDRAM High-Performance Controller to your system from the 
System Contents tab. 

1 The DDR3 SDRAM High-Performance Controller is in the SDRAM folder 
under the Memories and Memory Controllers folder. 

5. Specify the required parameters on all pages in the Parameter Settings tab.

Table 2–1. Advantages of the Parameterization Flows

SOPC Builder Flow MegaWizard Plug-In Manager Flow

■ Automatically-generated simulation 
environment

■ Create custom components and integrate 
them via the component wizard

■ All components are automatically 
interconnected with the Avalon-MM interface

■ Design directly from the DDR3 SDRAM 
interface to peripheral device(s)

■ Achieves higher-frequency operation
DDR3 SDRAM High-Performance Controller User Guide © March 2009 Altera Corporation
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Chapter 2: Getting Started 2–3
SOPC Builder Flow
f For detailed explanation of the parameters, refer to the “Parameter 
Settings” on page 3–1.

6. Click Finish to complete the DDR3 SDRAM High-Performance Controller 
MegaCore function and add it to the system. 

Complete the SOPC Builder System
To complete the SOPC Builder system, follow these steps:

1. In the System Contents tab, select Nios II Processor and click Add.

2. On the Nios II Processor page, in the Core Nios II tab, select altmemddr for Reset 
Vector and Exception Vector.

3. Change the Reset Vector Offset and the Exception Vector Offset to an Avalon 
address that is not written to by the ALTMEMPHY megafunction during its 
calibration process. 

c The ALTMEMPHY megafunction performs memory interface calibration 
every time it is reset and in doing so writes to addresses 0×0 to 0×47. If you 
want your memory contents to remain intact through a system reset, you 
should avoid using the memory addresses below 0×48. This step is not 
necessary, if you reload your SDRAM memory contents from flash every 
time you reset.

To calculate the Avalon-MM address equivalent of the memory address range 0×0 
to 0×47, multiply the memory address by the width of the memory interface data 
bus in bytes. For example, if your external memory data width is 8 bits, then the 
Reset Vector Offset should be 0×60 and the Exception Vector Offset should be 
0×80.

4. Click Finish.

5. On the System Contents tab, expand Interface Protocols and expand Serial.

6. Select JTAG UART and click Add.

7. Click Finish.

1 If there are warnings about overlapping addresses, on the System menu 
click Auto Assign Base Addresses.

If you enable ECC and there are warnings about overlapping IRQs, on the 
System menu click Auto Assign IRQs.

External Memory Interface Width Reset Vector Offset Exception Vector Offset

8 0×60 0×80

16 0×A0 0×C0

32 0×120 0×140

64 0×240 0×260
© March 2009 Altera Corporation DDR3 SDRAM High-Performance Controller User Guide



2–4 Chapter 2: Getting Started
MegaWizard Plug-In Manager Flow
8. For this example system, ensure all the other modules are clocked on the 
altmemddr_sysclk, to avoid any unnecessary clock-domain crossing logic.

9. Click Generate.

1 Among the files generated by SOPC Builder is the Quartus II IP File (.qip). 
This file contains information about a generated IP core or system. In most 
cases, the .qip file contains all of the necessary assignments and 
information required to process the MegaCore function or system in the 
Quartus II compiler. Generally, a single .qip file is generated for each SOPC 
Builder system. However, some more complex SOPC Builder components 
generate a separate .qip file. In that case, the system .qip file references the 
component .qip file.

10. To ensure the automatically-generated constraints function correctly, you must 
ensure the pin names and pin group assignments match, otherwise the design 
may not fit when you compile your design. You can either create your own top-
level design file or edit the altmemddr_example_top.v file to replace the example 
driver and the DDR3 SDRAM High-Performance controller, and instantiate your 
SOPC Builder-generated system.

Simulate the System
During system generation, SOPC Builder optionally generates a simulation model 
and testbench for the entire system, which you can use to easily simulate your system 
in any of Altera's supported simulation tools. SOPC Builder also generates a set of 
ModelSim® Tcl scripts and macros that you can use to compile the testbench, IP 
functional simulation models, and plain-text RTL design files that describe your 
system in the ModelSim simulation software.

f For more information about simulating the SOPC Builder system, refer to volume 4 of 
the Quartus II Handbook or AN 351: Simulating Nios II Systems.

MegaWizard Plug-In Manager Flow
The MegaWizard Plug-In Manager flow allows you to customize the DDR3 SDRAM 
High-Performance Controller MegaCore function, and manually integrate the 
function into your design.

1 You can alternatively use the IP Advisor to help you start your DDR3 SDRAM High-
Performance Controller MegaCore design. On the Quartus II Tools menu, point to 
Advisors, and then click IP Advisor. The IP Advisor guides you through a series of 
recommendations for selecting, parameterizing, evaluating, and instantiating a DDR3 
SDRAM High-Performance Controller MegaCore function into your design. It then 
guides you through a complete Quartus II compilation of your project.

f For more information about the MegaWizard Plug-In Manager and the IP Advisor, 
refer to the Quartus II Help.
DDR3 SDRAM High-Performance Controller User Guide © March 2009 Altera Corporation
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MegaWizard Plug-In Manager Flow
Specify Parameters
To specify DDR3 SDRAM High-Performance Controller parameters using the 
MegaWizard Plug-In Manager flow, follow these steps:

1. In the Quartus II software, create a new Quartus II project with the New Project 
Wizard. 

2. On the Tools menu, click MegaWizard Plug-In Manager and follow the steps to 
start the MegaWizard Plug-In Manager.

1 The DDR3 SDRAM High-Performance Controller MegaCore function is in 
the Interfaces folder under the Memory Controllers folder.

3. Specify the parameters on all pages in the Parameter Settings tab.

f For detailed explanation of the parameters, refer to the “Parameter 
Settings” on page 3–1.

4. On the EDA tab, turn on Generate simulation model to generate an IP functional 
simulation model for the MegaCore function in the selected language.

An IP functional simulation model is a cycle-accurate VHDL or Verilog HDL 
model produced by the Quartus II software.

c Use the simulation models only for simulation and not for synthesis or any 
other purposes. Using these models for synthesis creates a nonfunctional 
design.

1 Some third-party synthesis tools can use a netlist that contains only the 
structure of the MegaCore function, but not detailed logic, to optimize 
performance of the design that contains the MegaCore function. If your 
synthesis tool supports this feature, turn on Generate netlist.

c The memory model generated by the wizard cannot be used if you select 
Full Calibration (long simulation time). You must use a memory-vendor 
provided memory model.

5. On the Summary tab, select the files you want to generate. A gray checkmark 
indicates a file that is automatically generated. All other files are optional.

f For more information about the files generated in your project directory, 
refer to Table 2–2.

6. Click Finish to generate the MegaCore function and supporting files.

7. If you generate the MegaCore function instance in a Quartus II project, you are 
prompted to add the .qip files to the current Quartus II project. When prompted to 
add the .qip files to your project, click Yes. The addition of the .qip files enables 
their visibility to Nativelink. Nativelink requires the .qip files to include libraries 
for simulation. 
© March 2009 Altera Corporation DDR3 SDRAM High-Performance Controller User Guide
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MegaWizard Plug-In Manager Flow
1 The .qip file is generated by the MegaWizard interface, and contains 
information about the generated IP core. In most cases, the .qip file contains 
all of the necessary assignments and information required to process the 
MegaCore function or system in the Quartus II compiler. The MegaWizard 
interface generates a single .qip file for each MegaCore function.

8. After you review the generation report, click Exit to close the MegaWizard Plug-In 
Manager.

Table 2–2 describes the generated files and other files (AFI mode) that may be in 
your project directory. The names and types of files specified in the MegaWizard 
Plug-In Manager report vary based on whether you created your design with 
VHDL or Verilog HDL.

Table 2–2. Generated Files (Part 1 of 3)

Filename Description

<variation name>.bsf Quartus II symbol file for the MegaCore function variation. 
You can use this file in the Quartus II block diagram editor.

<variation name>.html MegaCore function report file.

<variation name>.v or .vhd A MegaCore function variation file, which defines a VHDL or 
Verilog HDL top-level description of the custom MegaCore 
function. Instantiate the en‘tity defined by this file inside of 
your design. Include this file when compiling your design in 
the Quartus II software.

<variation name>.qip Contains Quartus II project information for your MegaCore 
function variations.

<variation name>.ppf This XML file describes the MegaCore pin attributes to the 
Quartus II Pin Planner. MegaCore pin attributes include pin 
direction, location, I/O standard assignments, and drive 
strength. If you launch IP Toolbench outside of the Pin 
Planner application, you must explicitly load this file to use 
Pin Planner.

<variation name>_auk_ddr3_hp_controller_wrapper.vo or 
.vho

VHDL or Verilog HDL IP functional simulation model.

<variation name>_example_driver.v or .vhd Example self-checking test generator that matches your 
variation.

<variation name>_example_top.v or .vhd Example top-level design file that you should set as your 
Quartus II project top level. Instantiates the example driver 
and the controller.

<variation name>_example_top_tb.v or .vhd Example testbench that instantiates the example top-level 
design file and the example memory model.

alt_mem_phy_defines.v Contains constants used in the interface. This file is always 
in Verilog HDL regardless of the language you chose in the 
MegaWizard Plug-In Manager.

<variation_name>_phy.html Lists the top-level files created and ports used in the 
megafunction.

<variation_name>_phy.v/.vhd Top-level file of your ALTMEMPHY variation, generated 
based on the language you chose in the MegaWizard 
Plug-In Manager.

<variation_name>_phy.vho Contains functional simulation model for VHDL only. 
DDR3 SDRAM High-Performance Controller User Guide © March 2009 Altera Corporation
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MegaWizard Plug-In Manager Flow
<variation_name>_phy_alt_mem_phy_delay.vhd Includes a delay module for simulation. This file is only 
generated if you choose VHDL as the language of your 
MegaWizard Plug-In Manager output files.

<variation_name>_phy_alt_mem_phy_dq_dqs.vhd or .v Generated file that contains DQ/DQS I/O atoms 
interconnects and instance. Arria II GX devices only.

<variation_name>_phy_alt_mem_phy_dq_dqs_clearbox.txt Specification file that generates the 
<variation_name>_alt_mem_phy_dq_dqs file using the 
clearbox flow. Arria II GX devices only.

<variation_name>_phy_alt_mem_phy_pll.qip Quartus II IP file for the PLL that your ALTMEMPHY 
variation uses that contains the files associated with this 
megafunction.

<variation_name>_phy_alt_mem_phy_pll.v/.vhd The PLL megafunction file for your ALTMEMPHY variation, 
generated based on the language you chose in the 
MegaWizard Plug-In Manager.

<variation_name>_phy_alt_mem_phy_pll_bb.v/.cmp Black box file for the PLL used in your ALTMEMPHY 
variation. Typically unused.

<variation_name>_phy_alt_mem_phy_reconfig.qip Quartus II IP file for the PLL reconfiguration block. Only 
generated when targeting Arria GX, Arria II GX, 
HardCopy II, Stratix II, and Stratix II GX devices.

<variation_name>_phy_alt_mem_phy_reconfig.v/.vhd PLL reconfiguration block module. Only generated when 
targeting Arria GX, Arria II GX, HardCopy II, Stratix II, and 
Stratix II GX devices.

<variation_name>_phy_alt_mem_phy_reconfig_bb.v/cmp Blackbox file for the PLL reconfiguration block. Only 
generated when targeting Arria GX, Arria II GX, 
HardCopy II, Stratix II, and Stratix II GX devices.

<variation_name>_phy_alt_mem_phy_seq.vhd Contains the sequencer used during calibration. This file is 
encrypted and is always in VHDL language regardless of the 
language you chose in the MegaWizard Plug-In Manager. 

<variation_name>_phy_alt_mem_phy_seq_wrapper.v/.vhd A wrapper file, for compilation only, that calls the sequencer 
file, created based on the language you chose in the 
MegaWizard Plug-In Manager. 

<variation_name>_phy_alt_mem_phy_seq_wrapper.vo/.vho A wrapper file, for simulation only, that calls the sequencer 
file, created based on the language you chose in the 
MegaWizard Plug-In Manager.

<variation_name>_phy_alt_mem_phy.v Contains all modules of the ALTMEMPHY variation except 
for the sequencer. This file is always in Verilog HDL 
language regardless of the language you chose in the 
MegaWizard Plug-In Manager. The DDR3 SDRAM 
sequencer is included in the 
<variation_name>_alt_mem_phy.vhd file.

<variation_name>_phy_bb.v/.cmp Black box file for your ALTMEMPHY variation, depending 
whether you are using Verilog HDL or VHDL language.

<variation_name>_phy_ddr_pins.tcl Contains procedures used in the 
<variation_name>_report_timing.tcl file.

<variation_name>_phy_ddr_timing.sdc Contains timing constraints for your ALTMEMPHY 
variation. 

Table 2–2. Generated Files (Part 2 of 3)

Filename Description
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9. Set the <variation name>_example_top.v or .vhd file to be the project top-level 
design file.

a. On the File menu, click Open.

b. Browse to <variation name>_example_top and click Open.

c. On the Project menu, click Set as Top-Level Entity.

10. Simulate the example design (refer to “Simulate the Example Design” on 
page 2–8) and compile (refer to “Compile the Design” on page 2–13).

Simulate the Example Design
You can simulate the example design with the MegaWizard Plug-In Manager-
generated IP functional simulation models. The MegaWizard Plug-In Manager 
generates a VHDL or Verilog HDL testbench for your example design and a 
simulation model of the memory you are targeting, which are in the testbench 
directory in your project directory.

You can use the IP functional simulation model with any Altera-supported VHDL or 
Verilog HDL simulator. 

You can perform a simulation in a third-party simulation tool from within the 
Quartus II software, using NativeLink.

f For more information on NativeLink, refer to the Simulating Altera IP Using NativeLink 
chapter in volume 3 of the Quartus II Handbook.

Simulating Using NativeLink
To set up simulation in the Quartus II software using NativeLink, follow these steps:

1. Create a custom variation with an IP functional simulation model, refer to step 4 in 
the “Specify Parameters” section on page 2–2. 

2. Set the top-level entity to the example project. 

a. On the File menu, click Open. 

b. Browse to <variation name>_example_top and click Open. 

c. On the Project menu, click Set as Top-Level Entity. 

<variation_name>_phy_report_timing.tcl Script that reports timing for your ALTMEMPHY variation 
during compilation.

<variation_name>_pin_assignments.tcl Contains I/O standard, drive strength, output enable 
grouping, and termination assignments for your 
ALTMEMPHY variation. If your top-level design pin names 
do not match the default pin names or a prefixed version, 
edit the assignments in this file.

Table 2–2. Generated Files (Part 3 of 3)

Filename Description
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3. Set up the Quartus II NativeLink.

a. On the Assignments menu, click Settings. In the Category list, expand EDA 
Tool Settings and click Simulation. 

b. From the Tool name list, click on your preferred simulator.

1 Check that the absolute path to your third-party simulator executable is set. 
On the Tools menu, click Options and select EDA Tools Options.

c. In NativeLink settings, select Compile test bench and click Test Benches. 

d. Click New at the Test Benches page to create a testbench.

4. In the New Test Bench Settings dialog box, do the following:

a. Enter a name for the Test bench name.

b. In Top level module in test bench, enter the name of the automatically 
generated testbench, <variation name>_example_top_tb.

c. In Design instance in test bench, enter the name of the top-level instance, dut.

d. Under Simulation period, set End simulation at to 600 µs.

e. Add the testbench files and automatically-generated memory model files. In 
the File name field, browse to the location of the memory model and the 
testbench, click Open and then click Add. The testbench is 
<variation name>_example_top_tb.v; memory model is 
<variation name>_mem_model.v.

f The auto generated generic SDRAM model may be used as a placeholder 
for a specific memory vendor supplied model. For information on how to 
replace the generic model with a vendor specific model, refer to “Perform 
RTL/Functional Simulation (Optional)” in AN 436: Using DDR3 SDRAM 
in Stratix III and Stratix IV Devices.

f. Select the files and click OK.

5. On the Processing menu, point to Start and click Start Analysis & Elaboration to 
start analysis.

6. On the Tools menu, point to Run EDA Simulation Tool and click EDA RTL 
Simulation. 

IP Functional Simulations
For VHDL simulations with IP functional simulation models, perform the following 
steps:

1. Create a directory in the <project directory>\testbench directory.
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2. Launch your simulation tool from this directory and create the following libraries:

■ altera_mf

■ lpm

■ sgate

■ <device name>

■ altera

■ ALTGXB

■ <device name>_hssi

■ auk_ddr3_hp_user_lib

3. Compile the files into the appropriate library (AFI mode) as shown in Table 2–3. 
The files are in VHDL93 format.

Table 2–3. Files to Compile—VHDL IP Functional Simulation Models (Part 1 of 2)

Library File Name

altera_mf <QUARTUS ROOTDIR>/eda/sim_lib/altera_mf_components.vhd

<QUARTUS ROOTDIR>/eda/sim_lib/altera_mf.vhd

lpm /eda/sim_lib/220pack.vhd

/eda/sim_lib/220model.vhd

sgate eda/sim_lib/sgate_pack.vhd

eda/sim_lib/sgate.vhd

<device name> eda/sim_lib/<device name>_atoms.vhd

eda/sim_lib/<device name>_ components.vhd

eda/sim_lib/<device name>_hssi_atoms.vhd (1)

altera eda/sim_lib/altera_primitives_components.vhd

eda/sim_lib/altera_primitives.vhd

ALTGXB (1) <device name>_mf.vhd

<device name>_mf_components.vhd

<device name>_hssi (1) <device name>_hssi_components.vhd

<device name>_hssi_atoms.vhd
DDR3 SDRAM High-Performance Controller User Guide © March 2009 Altera Corporation



Chapter 2: Getting Started 2–11
MegaWizard Plug-In Manager Flow
1 If you are targeting Stratix IV devices, you need both the Stratix IV and 
Stratix III files (stratixiv_atoms and stratixiii_atoms) to simulate in your 
simulator, unless you are using NativeLink.

4. Load the testbench in your simulator with the timestep set to picoseconds.

For Verilog HDL simulations with IP functional simulation models, follow these 
steps:

1. Create a directory in the <project directory>\testbench directory.

2. Launch your simulation tool from this directory and create the following libraries:

■ altera_mf_ver

■ lpm_ver

■ sgate_ver

■ <device name>_ver

■ altera_ver

■ ALTGXB_ver

■ <device name>_hssi_ver

■ auk_ddr3_hp_user_lib

3. Compile the files into the appropriate library (AFI mode) as shown in Table 2–4 on 
page 2–12.

auk_ddr3_hp_user_lib <QUARTUS ROOTDIR>/

libraries/vhdl/altera/altera_europa_support_lib.vhd

<project directory>/<variation name>_phy_alt_mem_phy_delay.vhd

<project directory>/<variation name>_phy_alt_mem_phy_seq_wrapper.vho

<project directory>/<variation name>_auk_ddr3_hp_controller_wrapper.vho

<project directory>/<variation name>_phy.vho

<project directory>/<variation name>.vhd

<project directory>/<variation name>_example_top.vhd

<project directory>/<variation name>_controller_phy.vhd

<project directory>/<variation name>_phy_alt_mem_phy_pll.vhd

<project directory>/<variation name>_phy_alt_mem_phy_seq.vhd

<project directory>/<variation name>_example_driver.vhd

<project directory>/<variation name>_ex_lfsr8.vhd

testbench/<variation name>_example_top_tb.vhd

testbench/<variation name>_mem_model.vhd

Note for :

(1) Applicable only for Stratix IV devices.

Table 2–3. Files to Compile—VHDL IP Functional Simulation Models (Part 2 of 2)

Library File Name
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1 If you are targeting Stratix IV devices, you need both the Stratix IV and 
Stratix III files (stratixiv_atoms and stratixiii_atoms) to simulate in your 
simulator, unless you are using NativeLink.

4. Configure your simulator to use transport delays, a timestep of picoseconds, and 
to include all the libraries in Table 2–4.

Table 2–4. Files to Compile—Verilog HDL IP Functional Simulation Models

Library File Name

altera_mf_ver <QUARTUS ROOTDIR>/eda/sim_lib/altera_mf.v

lpm_ver /eda/sim_lib/220model.v

sgate_ver eda/sim_lib/sgate.v

<device name>_ver eda/sim_lib/<device name>_atoms.v

eda/sim_lib/<device name>_hssi_atoms.v (1)

altera_ver eda/sim_lib/altera_primitives.v

ALTGXB_ver (1) <device name>_mf.v

<device name>_hssi_ver (1) <device name>_hssi_atoms.v

auk_ddr3_hp_user_lib alt_mem_phy_defines.v

<project directory>/<variation name>_phy_alt_mem_phy_seq_wrapper.vo

<project directory>/<variation name>_auk_ddr3_hp_controller_wrapper.vo

<project directory>/<variation name>.v

<project directory>/<variation name>_example_top.v

<project directory>/<variation name>_phy.v

<project directory>/<variation name>_controller_phy.v

<project directory>/<variation name>_phy_alt_mem_phy_pll.v

<project directory>/<variation name>_phy_alt_mem_phy.v

<project directory>/<variation name>_example_driver.v

<project directory>/<variation name>_ex_lfsr8.v

testbench/<variation name>_example_top_tb.v

testbench/<variation name>_mem_model.v

Notes for :

(1) Applicable only for Stratix IV devices.
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Compile the Design
To use the Quartus II software to compile your design and perform post-compilation 
timing analysis, follow these steps:

1. Set up the TimeQuest timing analyzer.

a. On the Assignments menu, click Timing Analysis Settings, select Use 
TimeQuest Timing Analyzer during compilation, and click OK. 

b. Add the Synopsys Design Constraints (.sdc) files, 
<variation name>_phy_ddr_timing.sdc, to your project. On the Project menu, 
click Add/Remove Files in Project and browse to select the file.

c. Add the .sdc file for the example top-level design, 
<variation name>_example_top.sdc, to your project. This file is only required if 
you are using the example as the top level design.

2. Use one of the following procedures to specify I/O standard assignments for pins: 

■ If you have a single DDR3 SDRAM interface, and your top-level pins have default 
naming shown in the example design, run <variation name>_pin_assignments.tcl. 

■ If your design contains pin names that do not match the design, edit the 
<variation name>_pin_assignments.tcl file before you run the script. Follow these 
steps:

a. Open <variation name>_pin_assignments.tcl file.

b. Based on the flow you are using, set the sopc_mode value to Yes or No.

■ SOPC Builder System flow:

if {![info exists sopc_mode]} {set sopc_mode YES}

■ MegaWizard Plug-In Manager flow:

if {![info exists sopc_mode]} {set sopc_mode NO}

c. Type your preferred prefix in the pin_prefix variable. For example, to add 
the prefix my_mem, do the following:

if {![info exists set_prefix}{set pin_prefix “my_mem_”}

After setting the prefix, the pin names are expanded as shown in the following:

■ SOPC Builder System flow:

my_mem_cs_n_from_the_<your instance name>

■ MegaWizard Plug-In Manager flow:

my_mem_cs_n[0]
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3. Set the top-level entity to the top-level design. 

a. On the File menu, click Open. 

b. Browse to your SOPC Builder system top-level design or <variation 
name>_example_top if you are using MegaWizard Plug-In Manager, and click 
Open. 

c. On the Project menu, click Set as Top-Level Entity. Browse to <variation 
name>_example_top and click Open. 

d. On the Project menu, click Set as Top-Level Entity. 

4. Assign the pin locations to the pins in your design.

■ Use either the Pin Planner or Assignment Editor to assign the clock source pin 
manually. Also choose which DQS pin groups should be used by assigning 
each DQS pin to the required pin. The Quartus II Fitter then automatically 
places the respective DQ signals onto suitable DQ pins within each group.

or

■ Manually specify all DQ and DQS pins to align your project with your PCB 
requirements.

or

■ Manually specify all project pin locations to align your project with your PCB 
requirements.

1 When assigning pins, ensure that you set an appropriate I/O standard for 
the non-memory interfaces, such as the clock source and the reset inputs. 
For example, for DDR3 SDRAM, select 1.5 V. Also select in which bank or 
side of the device you want the Quartus II software to place them.

5. For Stratix III and Stratix IV designs, if you are using advanced I/O timing, specify 
board trace models in the Device & Pin Options dialog box. If you are using any 
other device and not using advanced I/O timing, specify the output pin loading 
for all memory interface pins.

6. Select your required I/O driver strength (derived from your board simulation) to 
ensure that you correctly drive each signal or ODT setting and do not suffer from 
overshoot or undershoot.

7. To compile the design, on the Processing menu, click Start Compilation. 

Program Device and Implement the Design
After you compile the example design, you can perform RTL simulation (refer to 
“Simulate the Example Design” on page 2–8) or program your targeted Altera device 
to verify the example design in hardware. 

To implement your design based on the example design, replace the example driver 
in the example design with your own logic.
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3. Parameter Settings
Memory Settings
The Memory Settings page provides the same options as the ALTMEMPHY 
megafunction Memory Settings page.

f For more information on the memory settings, refer to the External Memory PHY 
Interface Megafunction User Guide (ALTMEMPHY).

PHY Settings
Board skew is the skew across all the memory interface signals, which includes clock, 
address, command, data, mask, and strobe signals.

f For more information on the PHY settings, refer to the External Memory PHY Interface 
Megafunction User Guide (ALTMEMPHY).

Controller Settings
Table 3–1 shows the options provided in the Controller Settings page. 

Table 3–1. Controller Settings

Parameter Range Description

Enable error detection and 
correction logic

On or off Turn on to add the optional ECC to the design, refer to “Error Correction 
Coding (ECC)” on page 4–6.

Enable user auto-refresh 
controls

On or off Turn on for user control of the refreshes, refer to “User Refresh Control” 
on page 4–16.

Enable auto-precharge 
control

On or off Turn on if you need fast random access, refer to “Auto-Precharge 
Commands” on page 4–18

Enable power down 
controls

On or off Turn on to enable the controller to allow you to place the external 
memory device in a power-down mode, refer to “Self-Refresh and 
Power-Down Commands” on page 4–17

Enable self-refresh controls On or off Turn on to enable the controller to allow you to place the external 
memory device in a self-refresh mode, refer to “Self-Refresh and Power-
Down Commands” on page 4–17

Local Interface Protocol Native or Avalon 
Memory-Mapped

Specifies the local side interface between the user logic and the memory 
controller. The Avalon-MM interface allows you to easily connect to other 
Avalon-MM peripherals.
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4. Functional Description
The DDR3 SDRAM High-Performance Controller MegaCore function instantiates 
encrypted control logic and the ALTMEMPHY megafunction. The controller accepts 
read and write requests from the user on its local interface, using either the Avalon-
MM interface protocol or the native interface protocol. It converts these requests into 
the necessary SDRAM commands, including any required bank management 
commands. Each read or write request on the Avalon-MM or native interface maps to 
one SDRAM read or write command. The DDR3 controller operates in half-rate mode 
and accepts requests of size 1 or 2 on the local interface. 

If you request a burst size of 1, the controller issues a memory burst of 4 using the 
DDR3 on-the-fly burst chop (waits for two cycles before issuing the next read or write 
command). If you request a burst size of 2, the controller issues a memory burst of 8 
(issues the next read or write command back to back). Requests of size 2 on the local 
interface produce better throughput because DDR3 memories cannot accept back to 
back bursts of size 4.

The bank management logic in the controller keeps a row open in every bank in the 
memory system. For example, a controller configured for a dual-rank, 8-bank DDR3 
SDRAM DIMM keeps an open row in each of the 16 banks. The controller allows you 
to request an auto-precharge read or auto-precharge write, allowing control over 
whether to keep that row open after the request. Maximum efficiency can be achieved 
by issuing reads and writes to the same bank, with the last access to that bank being 
an auto-precharge read or write. The controller does not do any access reordering.

f For more information on the ALTMEMPHY megafunction, refer to the External 
Memory PHY Interface Megafunction User Guide (ALTMEMPHY).

Block Description
Figure 4–1 on page 4–1 shows a block diagram of the DDR3 SDRAM high-
performance controller.

Figure 4–1. DDR3 SDRAM High-Performance Controller Block Diagram
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Block Description
Figure 4–2 shows a block diagram of the DDR3 SDRAM high-performance controller 
architecture.

The blocks in Figure 4–2 are described in the following sections.

Command FIFO
This FIFO allows the controller to buffer up to four consecutive read or write 
commands. It is built from logic elements, and stores the address, read or write flag, 
and burst count information. If this FIFO fills up, the local_ready signal to the user 
is deasserted until the main state machine takes a command from the FIFO.

Write Data FIFO
The write data FIFO holds the write data from the user until the main state machine 
can send it to the ALTMEMPHY megafunction (which does not have a write data 
buffer). In Avalon-MM interface mode, the user logic presents a write request, 
address, burst count, and one or more beats of data. The write data beats are placed 
into the FIFO until they are needed. In native interface mode, the user logic presents a 
write request, address, and burst count. The controller then requests the correct 
number of write data beats from the user via the local_wdata_req signal and the 
user logic must return the write data in the clock cycle after the write data request 
signal. 

This FIFO is sized to be deeper than the command FIFO to prevent it from filling up 
and interrupting streaming writes.

Write Data Tracking Logic
This logic keeps track of how many beats of write data are in the FIFO. In native 
interface mode, this logic manages how much more data to request from the user 
logic and issues the local_wdata_req signal.

Figure 4–2. DDR3 SDRAM High-Performance Controller Architecture Block Diagram
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Main State Machine
This state machine decides what DDR commands to issue based on inputs from the 
command FIFO, the bank management logic, and the timer logic. 

Bank Management Logic
The bank management logic keeps track the current state of each bank. It can keep a 
row open in every bank in your memory system. The state machine uses the 
information provided by this logic to decide whether it needs to issue bank 
management commands before it reads or writes to the bank. The controller always 
leaves the bank open unless the user requests an auto-precharge read or write. The 
periodic refresh process also causes all the banks to be closed. 

Timer Logic
The timer logic tracks whether the required minimum number of clock cycles has 
passed since the last relevant command was issued. For example, the timer logic 
records how many cycles have elapsed since the last activate command so that the 
state machine knows it is safe to issue a read or write command (tRCD). The timer logic 
also counts the number of clock cycles since the last periodic refresh command and 
sends a high priority alert to the state machine if the number of clock cycles has 
expired.

Initialization State Machine
The initialization state machine issues the appropriate sequence of command to 
initialize the memory devices. It is specific to DDR3 as each memory type requires a 
different sequence of initialization commands. 

If the ALTMEMPHY megafunction is in AFI mode, then the megafunction is 
responsible for initializing the memory. In this case, the controller does not have the 
initialization state machine. 

Address and Command Decode
When the state machine wants to issue a command to the memory, it asserts a set of 
internal signals. The address and command decode logic turns these into the DDR-
specific RAS/CAS/WE commands. 

PHY Interface Logic
When the main state machine issues a write command to the memory, the write data 
for that write burst has to be fetched from the write data FIFO. The relationship 
between write command and write data depends on the memory type, ALTMEMPHY 
interface type, CAS latency, and the full-rate or half-rate setting. The PHY interface 
logic adjusts the timing of the write data FIFO read request signal so that the data 
arrives on the external memory interface DQ pins at the correct time. 

ODT Generation Logic
The ODT generation logic (not shown) calculates when and for how long to enable the 
ODT outputs. It also decides which ODT bit to enable, based on the number of chip 
selects in the system.
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■ 1 DIMM (1 or 2 Chip Selects)

In the case of a single DIMM, the ODT signal is only asserted during writes. The 
ODT signal on the DIMM at mem_cs[0] is always used, even if the write 
command on the bus is to mem_cs[1]. In other words, mem_odt[0] is always 
asserted even if there are two ODT signals.

■ 2 or more DIMMs 

In the multiple DIMM case, the appropriate ODT bit is asserted for both read and 
writes. The ODT signal on the adjacent DIMM is enabled as shown. 

Low Power Mode Logic
The low power mode logic (not shown) monitors the local_powerdn_req and 
local_self_rfsh_req request signals. This logic also informs the user of the 
current low power state via that local_powerdn_ack and 
local_self_rfsh_ack acknowledge signals. 

Control Logic
Bus commands control SDRAM devices using combinations of the mem_ras_n, 
mem_cas_n, and mem_we_n signals. For example, on a clock cycle where all three 
signals are high, the associated command is a no operation (NOP). A NOP command 
is also indicated when the chip select signal is not asserted. Table 4–1 shows the 
standard SDRAM bus commands.

The DDR3 SDRAM high-performance controller must open SDRAM banks before 
they access addresses in that bank. The row and bank to be opened are registered at 
the same time as the active (ACT) command. The DDR3 SDRAM high-performance 
controller closes the bank and opens the bank again if it needs to access a different 
row. The precharge (PCH) command closes only a bank. 

If a write/read is happening to: ODT enabled:

mem_cs[0]or cs[1] mem_odt[2]

mem_cs[2] or cs[3] mem_odt[0]

mem_cs[4] or cs[5] mem_odt[6]

mem_cs[6] or cs[7] mem_odt[4]

Table 4–1. Bus Commands

Command Acronym ras_n cas_n we_n

No operation NOP High High High

Active ACT Low High High

Read RD High Low High

Write WR High Low Low

Precharge PCH Low High Low

Auto refresh ARF Low Low High

Load mode register LMR Low Low Low
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The primary commands used to access SDRAM are read (RD) and write (WR). When 
the WR command is issued, the initial column address and data word is registered. 
When a RD command is issued, the initial address is registered. The initial data 
appears on the data bus 5 to 11 clock cycles later. This delay is the column address 
strobe (CAS) latency and is due to the time required to read the internal DRAM core 
and register the data on the bus. The CAS latency (of 6) depends on the speed of the 
SDRAM and the frequency of the memory clock. In general, the faster the clock, the 
more cycles of CAS latency are required. After the initial RD or WR command, 
sequential reads and writes continue until the burst length is reached. DDR3 SDRAM 
devices support fixed burst lengths of 4 or 8 data cycles or a the on-the-fly mode 
where the controller can request a burst of 4 or 8 for each read or write command. 
This on-the-fly mode is the only mode supported. The auto-refresh command (ARF) 
is issued periodically to ensure data retention. This function is performed by the 
DDR3 SDRAM high-performance controller.

The load mode register command (LMR) configures the SDRAM mode register. This 
register stores the CAS latency, burst length, and burst type. 

f For more information, refer to the specification of the SDRAM that you are using.

Latency
There are two types of latency that you must consider for memory controller 
designs—read and write latencies. We define the read and write latencies as follows.

■ Read latency is the time it takes for the read data to appear at the local interface 
after you initiate the read request signal to the controller.

■ Write latency is the time it takes for the write data to appear at the memory 
interface after you initiate the write request signal to the controller.

Latency calculations are made with the following assumptions:

■ Reading and writing to the rows that are already open

■ The local_ready signal is asserted high (no wait states)

■ No refresh cycles occur before transaction

■ The latency is defined using the local side frequency and absolute time (ns)

1 For the half rate controller, the local side frequency is half the memory interface 
frequency.

Altera defines the read and write latencies in terms of the local interface clock 
frequency and by the absolute time for the memory controllers.
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Table 4–2 shows the read and write latency derived from the write and read latency 
definitions for half rate controllers, and for Stratix III and Stratix IV devices.

1 The exact latency depends on your precise configuration. You should obtain precise 
latency from simulation, but this figure may vary in hardware because of the 
automatic calibration process.

Error Correction Coding (ECC)
The ECC comprises an encoder and a decoder-corrector, which can detect and correct 
single-bit errors and detect double-bit errors. The ECC uses an 8-bit ECC for each 64-
bit message. The ECC has the following features:

■ Hamming code ECC that encodes every 64-bits of data into 72-bits of codeword 
with 8-bits of Hamming code parity bits

■ Latency:

■ Maximum of 1 or 2 clock delay during writes

■ Minimum 1 or 3 clock delay during reads

■ Detects and corrects all single-bit errors. Also the ECC sends an interrupt when 
the user-defined threshold for a single-bit error is reached.

■ Detects all double-bit errors. Also, the ECC counts the number of double-bit errors 
and sends an interrupt when the user-define threshold for double-bit error is 
reached.

■ Accepts partial writes

■ Creates forced errors to check the functioning of the ECC

■ Powers up in a sensible state

Table 4–2. Typical Latency

Device
Controller 

Rate
Frequency 

(MHz)
Latency 

Type

Total Latency

Local Clock 
Cycles

Time 
(ns)

Stratix III Half 400 Read 23 115

Write 14 68

Stratix IV Half 400 Read 23 115

Write 14 68
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Figure 4–3 shows the ECC block diagram
.

The ECC comprises the following blocks:

■ The encoder—encodes the 64-bit message to a 72-bit codeword

■ The decoder-corrector—decodes and corrects the 72-bit codeword if possible

■ The ECC controller—controls multiple encoder and decoder-correctors, so that the 
ECC can handle different bus widths. Also, it controls the following functions of 
the encoder and decoder-corrector:

■ Interrupts:

■ Detected and corrected single-bit error 

■ Detected double-bit error 

■ Single-bit error counter threshold exceeded 

■ Double-bit error counter threshold exceeded            

■ Configuration registers:

■ Single-bit error detection counter threshold 

■ Double-bit error detection counter threshold 

■ Capture status for first encountered error or most recent error 

■ Enable deliberate corruption of ECC for test purposes.

■ Status registers:

■ Error address 

■ Error type: single-bit error or double-bit error

■ Respective byte error ECC syndrome 

■ Error signal—an error signal corresponding to the data word is provided with 
the data and goes high if a double-bit error that cannot be corrected occurs in 
the return data word.

Figure 4–3. ECC Block Diagram
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■ Counters:

■ Detected and/or corrected single-bit errors 

■ Detected double-bit errors 

f For more information on the ECC registers, refer to Appendix A, ECC Register 
Description.

The ECC can instantiate multiple encoders, each running in parallel, to encode any 
width of data words assuming they are integer multiples of 64. 

The ECC operates between the local (native or Avalon-MM interface) and the 
memory controller. 

The ECC has an N × 64-bit (where N is an integer) wide interface, between the local 
interface and the ECC, for receiving and returning data from the local interface. This 
interface can be a native interface or an Avalon-MM slave interface, you select the 
type of interface in the MegaWizard interface.

The ECC has a second interface between the local interface and the ECC, which is a 
32-bit wide Avalon-MM slave to control and report the status of the operation of the 
ECC controller.

The encoded data from the ECC is sent to the memory controller using a N × 72-bit 
wide Avalon-MM master interface, which is between the ECC and the memory 
controller.

When testing the DDR3 SDRAM high-performance controller, you can turn off the 
ECC.

Interrupts
The ECC issues an interrupt signal when one of the following scenarios occurs: 

■ The single-bit error counter reaches the set maximum single-bit error threshold 
value.

■ The double-bit error counter reaches the set maximum double-bit error threshold 
value.

The error counters increment every time the respective event occurs for all N parts of 
the return data word. This incremented value is compared with the maximum 
threshold and an interrupt signal is sent when the value is equal to the maximum 
threshold. The ECC clears the interrupts when you write a 1 to the respective status 
register. You can mask the interrupts from either of the counters using the control 
word.

Partial Writes
The ECC supports partial writes. Along with the address, data, and burst signals, the 
Avalon-MM interface also supports a signal vector that is responsible for byte-enable. 
Every bit of this signal vector represents a byte on the data-bus. Thus, a 0 on any of 
these bits is a signal for the controller not to write to that particular location—a partial 
write. For partial writes, the ECC performs the following steps:

■ Stalls further read or write commands from the Avalon-MM interface when it 
receives a partial write condition.
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■ Simultaneously sends a self-generated read command, for the partial write 
address, to the memory controller.

■ Upon receiving a return data from the memory controller for the particular 
address, the ECC decodes the data, checks for errors, and then sends it to the ECC 
controller. 

■ The ECC controller merges the corrected or correct dataword with the incoming 
information.

■ Sends the updated dataword to the encoder for encoding and then sends to the 
memory controller with a write command.

■ Releases the stall of commands from the Avalon-MM interface, which allows it to 
receive new commands.

The following corner cases can occur:

■ A single-bit error during the read phase of the read-modify-write process. In this 
case, the single-bit error is corrected first, the single-bit error counter is 
incremented and then a partial write is performed to this corrected decoded data 
word.

■ A double-bit error during the read phase of the read-modify-write process. In this 
case, the double-bit error counter is incremented and an interrupt is sent through 
the Avalon-MM interface. The new write word is not written to its location. A 
separate field in the interrupt status register highlights this condition.

Partial Bursts
Some DIMMs do not have the DM pins and so do not support partial bursts. A 
minimum of four words must be written to the memory at the same time. In cases of 
partial burst write, the ECC offers a mechanism similar to the partial write. 

In cases of partial bursts, the write data from the native interface is stored in a 64-bit 
wide FIFO buffer of maximum burst size depth, while in parallel a read command of 
the corresponding addresses is sent to the DIMM. Further commands from native 
interface are stalled until the current burst is read, modified, and written back to the 
memory controller.

ECC Latency
Using the ECC results in the following latency changes:

■ For a local burst length of 1, the write latency increases by one clock cycle; the read 
latency increases by one clock cycle (including checking and correction).

■ A partial write results in a read followed by write in the ECC controller, so latency 
depends on the time the controller takes to fetch the data from the particular 
address.

■ For a single-bit error, the automatic correction of memory takes place without 
stalling the read cycle (if enabled), which stalls further commands to the ECC 
controller, while the correction takes place.
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Example Design
The MegaWizard Plug-In Manager helps you create an example design that shows 
you how to instantiate and connect the DDR3 SDRAM high-performance controller. 
The example design consists of the DDR3 SDRAM high-performance controller and 
some driver logic to issue read and write requests to the controller. The example 
design is a working system that you can compile and use for both static timing checks 
and board tests. 

Figure 4–4 shows the testbench and the example design.

Table 4–3 describes the files that are associated with the example design and the 
testbench. 

Example Driver
The example driver is a self-checking test pattern generator for the memory interface. 
It uses a state machine to write and read from the memory to verify that the interface 
is operating correctly. 

Figure 4–4. Testbench & Example Design
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Control 
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test_complete 
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Example Design 
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DDR3 SDRAM Controller Wizard-
Generated

 Memory Model

DLL
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Table 4–3. Example Design & Testbench Files

Filename Description

<variation name>_example_top_tb.v or .vhd Testbench for the example design.

<variation name>_example_top.v or .vhd Example design.

<variation name>_example_driver.v or .vhd Example driver.

<variation name>_mem_model.v or .vhd Wizard-generated memory model.

<variation name>.v or .vhd Top-level description of the custom MegaCore function.

<variation name>.qip Contains Quartus II project information for your MegaCore function 
variations.
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It performs the following tests and loops back the tests indefinitely:

■ Sequential addressing writes and reads

The state machine writes pseudo-random data generated by a linear feedback shift 
register (LFSR) to a set of incrementing row, bank, and column addresses. The 
state machine then resets the LFSR, reads back the same set of addresses, and 
compares the data it receives against the expected data. You can adjust the length 
and pattern of the bursts that are written by changing the MAX_ROW, MAX_BANK, 
and MAX_COL constants in the example driver source code, and the entire memory 
space can be tested by adjusting these values. You can skip this test by setting the 
test_seq_addr_on signal to logic zero.

■ Incomplete write operation

The state machine issues a series of write requests that are less than the maximum 
burst size supported by your controller variation. The addresses are then read 
back to ensure that the controller has issued the correct signals to the memory. 
This test is only applicable in full-rate mode or in DDR3 half-rate mode, when the 
local burst size is two. You can skip this test by setting the 
test_incomplete_writes_on signal to logic zero.

■ Byte enable/data mask pin operation

The state machine issues two sets of write commands, the first of which clears a 
range of addresses. The second set of write commands has only one byte enable bit 
asserted. The state machine then issues a read request to the same addresses and 
the data is verified. This test checks if the data mask pins are operating correctly. 
You can skip this test by setting the test_dm_pin_on signal to logic zero.

■ Address pin operation

The example driver generates a series of write and read requests starting with an 
all-zeros pattern, a walking-one pattern, a walking-zero pattern, and ending with 
an all-zeros pattern. This test checks to make sure that all the individual address 
bits are operating correctly. You can skip this test by setting the 
test_addr_pin_on signal to logic zero.

■ Low-power mode operation

The example driver requests the controller to place the memory into power-down 
and self-refresh states, and hold it in those states for the amount of time specified 
by the COUNTER_VALUE signal. You can vary this value to adjust the duration the 
memory is kept in the low-power states. This test is only available if your 
controller variation enables the low-power mode option.

The example driver has four outputs that allow you to observe which tests are 
currently running and if the tests are passing. The pass not fail (pnf) signal goes low 
once one or more errors occur and remains low. The pass not fail per byte 
(pnf_per_byte) signal goes low when there is incorrect data in a byte but goes back 
high again once correct data is observed in the following byte. The test_status 
signal indicates the test that is currently running, allowing you to determine which 
test has failed. The test_complete signal goes high for a single clock cycle at the 
end of the set of tests.
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Table 4–4 shows the bit mapping for each test status.

f For more details on how to run the simulation script, refer to “Simulate the Example 
Design” on page 2–8.

Interfaces & Signals 
This section describes the following topics:

■ “Interface Description” on page 4–12

■ “Signals” on page 4–19

Interface Description
This section describes the following local-side interface requests:

■ “Writes”

■ “Reads” on page 4–14

■ “User Refresh Control” on page 4–16

■ “Self-Refresh and Power-Down Commands” on page 4–17

■ “Auto-Precharge Commands” on page 4–18

■ “Initialization Timing” on page 4–18

1 These interface requests are for the native interface. For the Avalon-MM interface, 
refer to the Avalon Interface Specifications.

Writes
Figure 4–5 on page 4–13 shows three back-to-back write requests of size 2, to 
sequential addresses. The DDR3 SDRAM controller supports the on-the-fly burst 
mode. This mode allows you to request bursts of length 1 or 2 on the local side 
interface (equivalent to 4 or 8 on the DDR3 SDRAM side interface).

Table 4–4. Test Status[] Bit Mapping

Bit Test

0 Sequential address test

1 Incomplete write test

2 Data mask pin test

3 Address pin test

4 Power-down test

5 Self-refresh test

6 Auto precharge test
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The following sequence corresponds with the numbered items in Figure 4–5.

1. The user logic requests the first write, by asserting the local_write_req, 
local_burstbegin, size and address signals for this write. In this example, the 
request is a burst of length 2 (8 on the DDR3 SDRAM side) to address 0. The 
local_ready signal is asserted, which indicates that the controller has accepted 
this request, and the user logic can request another read or write in the following 
clock cycle. If the local_ready signal is not asserted, the user logic must keep 
the write request, size, and address signals asserted. For this burst of length 2, you 
must present the second beat of write data in the next clock cycle.

1 local_be is active high; mem_dm is active low. 

To map local_wdata and local_be to mem_dq and mem_dm, consider the 
following full rate example with 32-bit local_wdata and 16-bit mem_dq. 

Figure 4–5. Writes

phy_clk

2

0 1000 0 1008 0 01010

0

0

0 2 3 0

3 0

1000 0 1008 0 01010

F

0A1B 2C3D 4E5F 6A7B 8C9D AEBF

0A1B 2C3D 4E5F 6A7B 8C9D AEBF

0002 0004

local_ready

local_address

local_write_req

local_read_req

local_burstbegin

local_size

local_wdata

local_be

Controller Command Output

Controller Avalon-MM
Interface

ddr_a

ddr_ba

ddr_cs_n

ddr_ras_n

ddr_cas_n

ddr_we_n

Controller Data Interface

ctl_dqs_burst

ctl_wdata_valid

ctl_wdata

ctl_dm

ALTMEMPHY Outputs

mem_clk

mem_a

mem_cs_n

mem_ras_n

mem_cas_n

mem_we_n

mem_dq

mem_dqs

mem_dm

[1] [3][2] [5][6] [7][4]
© March 2009 Altera Corporation DDR3 SDRAM High-Performance Controller User Guide



4–14 Chapter 4: Functional Description
Interfaces & Signals
.

These values map to: 

2. The user logic requests a second write to a sequential address, of size 2 (8 on the 
DDR3 SDRAM side). The local_ready signal remains asserted, which indicates 
that the controller has accepted the request. 

3. The user logic requests the third write. The controller is able to buffer up to four 
requests so the local_ready signal stays high and the request is accepted.

4. The controller issues the necessary bank activation command and the three write 
commands sequentially to the ALTMEMPHY megafunction, which converts these 
commands from half-rate to full-rate and issues them to the memory device.

5. The controller asserts the signals that control how long the DQS 
(ctl_dqs_burst) and DQ (ctl_wdata_valid) outputs are enabled for. The 
ctl_dqs_burst and ctl_wdata_valid signals are two bits wide so that the 
controller can control how many full-rate mem_clk cycles the DQS and DQ signals 
are enabled for, even though the controller is operating on the half-rate clock. In 
this example, the DQS outputs are enabled for 13 full-rate clock cycles (to account 
for the DQS preamble) and the DQ is enabled for 12 full-rate clock cycles. The 
write data (ctl_wdata) and mask (ctl_dm) are issued at the same time as the 
ctl_wdata_valid.

6. The ALTMEMPHY megafunction issues the bank activation and write commands 
to the memory device. 

7. The ALTMEMPHY megafunction issues the DQS, DQ and DM signals to write the 
data to the memory device. 

Reads
Figure 4–6 on page 4–15 shows three read requests of size 2. The DDR3 SDRAM 
controller supports the on-the-fly burst mode. This mode allows you to request bursts 
of length 1 or 2 on the local side interface (equivalent to 4 or 8 on the DDR3 SDRAM 
side interface).

local_wdata = <22334455> <667788AA> <BBCCDDEE>

local_be = <1100> <0110> <1010>

mem_dq = <4455> <2233> <88AA> <6677> <DDEE> <BBCC>

mem_dm = <1 1> <0 0> <0 1> <1 0> <0 1> <0 1>
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The following sequence corresponds with the numbered items in Figure 4–6.

1. The user logic requests the three back-to-back reads of size 2 (8 on the DDR3 
SDRAM side) by asserting the local_read_req, local_burstbegin, 
local_size and local_address signals for each read. The local_ready 
signal is asserted, which indicates that the controller has accepted each request, 
and the user logic can request another read or write in the following clock cycle. If 
the local_ready signal is not asserted, the user logic must keep the read request, 
size, and address signals asserted. 

2. The controller issues the necessary bank activation command and the three read 
commands sequentially to the ALTMEMPHY megafunction, which converts these 
commands from half-rate to full-rate and issues them to the memory device.

3. The controller asserts the ctl_doing_read signals to indicate to the 
ALTMEMPHY megafunction when and for how long to enable to the capture 
registers. 

4. The ALTMEMPHY megafunction issues the bank activation and read commands 
to the memory device. 

Figure 4–6. Reads
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